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Chapter 1

Introduction

Thank you for your purchase of the MyProx sensor and 

software. This guide will introduce you to the MyProx 

family of products, including MyProx software, a 

powerful tool for customizing MyProx sensors. 

Programming the MyProx has never been easier. From 

the factory, the MyProx sensor has been programmed 

to meet the needs of most standard applications. 

However, in many cases, it may be preferable to 

customize the characteristics of the sensor, enable 

advanced sensing features, or clone an MyProx from 

a competitive sensor confi guration. This software 

application will allow you to do just that—and a whole 

lot more.

Using this Guide

This user guide provides detailed instructions for 

installing the software, programming your MyProx 

sensor, and troubleshooting software issues.

Chapter 2, Getting Started, reviews the steps for 

installing MyProx and attaching a Remote Programmer 

(E59RP1) or Tray Programmer (E59TP1) device.

Chapter 3, Programming MyProx, will cover the three 

programming methods--Confi gure, Clone and Teach. 

Advanced programming features, such as cloning from 

the cross reference database, will also be explained in 

this chapter.

Chapter 4, Troubleshooting, provides a detailed list of 

frequently asked questions and contact information for 

additional support, if needed.

Chapter 5, Glossary, explains common sensing 

terminology. Underlined text indicates a defi nition of 

the term is available within the glossary.

MyProx Overview

The MyProx family of sensors is unlike any other 

inductive proximity sensor on the market. Beyond its 

advanced built-in features such as extended sensing 

rang, the MyProx boasts the most extensive set of 

programmable features ever introduced in a tubular 

inductive proximity sensor. And with MyProx and a 

Remote Programmer (E59RP1) or Tray Programmer 

(E59TP1), you can quickly and easily customize a 

sensor to your specifi c application--even if it’s a 

particularly tough one. 

For more information on MyProx features and 

specifi cations, visit www.meyle.de. 
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Chapter 2

Getting Started

This chapter will walk you through installing the 

MyProx and connection devices, such as the Remote 

Programmer (E59RP1) or Tray Programmer (E59TP1), 

needed to attach the MyProx sensor to your computer.

System Requirements

Before installing MyProx, verify your computer and its 

software confi rm to the following system requirements 

and recommendations:

• Windows 98/2000/XP operating system

• Intel Pentium II processor or better

• 128 MB RAM minimum

• 300 MB available hard disk space

• Serial or USB port for sensor communication

• SVGA color monitor recommended

Installing MyProx

This section describes how to install MyProx (E59SW1) 

and start the application for the first time. Before 

you begin, verify your computer meets the system 

requirements listed above.

To install MyProx from a CD-ROM:

1. Uninstall any previous installation of the 

software before attempting to install MyProx. 

(Uninstalling will not remove any sensor 

database entries.)

2. Insert the MyProx compact disc into your 

computer’s disc drive.

3. Once the disc has been inserted, the installer 

will automatically launch the setup program. If 

this does not start automatically, go to the Start 

Menu, then click Run... Then type D:\setup.exe 

(where “D” is the drive letter of your CD-ROM).

4. Follow the on-screen instructions to install the 

software.

Once the software has been installed, connect the 

Remote Programmer (E59RP1) or Tray Programmer 

(E59TP1) to your computer by following the steps on 

the next page.
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Connecting the Tray Programmer (E59TP1)

To connect the Tray Programmer (E59TP1) to your 

computer, follow the steps below.

1. Ensure MyProx has been installed. (Look for 

the icon on the Desktop or Start Menu.)

2. Power the Tray Programmer (E59TP1) using the 

included AC Adapter.

3. Plug the square end of the USB cable into the 

back of the Tray Programmer (E59TP1).

4. Plug the fl at end of the USB cable into the 

computer’s USB port.

5. The Tray Programmer (E59TP1) should be 

automatically detected by Windows. If the 

device is not automatically detected, ensure 

the station is powered. (An active red LED 

should be visible from the back of the unit.) 

Next, confi rm both sides of the USB cable are 

securely connected. If problems persist, skip to 

the troubleshooting section in Chapter 4.

6. Launch the MyProx by clicking the icon on the 

Desktop or from the Start Menu.

Using the Tray Programmer (E59TP1)

After the Tray Programmer (E59TP1) is properly 

connected to your computer, screw on the mating AC 

or DC Micro, Mini or Cable Connector to the sensor as 

pictured below.

Next, fi rmly push the sensor into a station receptacle. 

The four receptacles on the Tray Programmer face 

accept MyProx sensors ranging from 12 to 30 

millimeters in diameter. Ensure the sensor face 

is touching the base of the station cup. For larger 

diameter sensors, it may be required to unscrew the 

mounting nuts to completely fi t the sensor into the 

receptacle. Once the sensor is positioned inside the 

receptacle, plug the male end of the sensor connector 

into the adjacent outlet as pictured below.
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Connecting the Remote Programmer (E59RP1)

To connect the Remote Programmer (E59RP1) to your 

computer, follow the steps below.

1. Ensure MyProx has been installed. (Look for 

the icon on the Desktop or Start Menu.)

2. Plug the Remote Programmer (E59RP1) into an 

available serial port on your computer. Most 

desktop and laptop computers include serial 

connectors on the back, but if your computer 

does not include this port, Serial (DB9) to 

USB adapters are available at computer retail 

outlets.

3. Launch MyProx by clicking the icon on the 

Desktop or from the Start Menu.

4. If the computer does not appear to recognize 

the Remote Programmer (E59RP1), skip to 

Chapter 4, Troublshooting.

Using the Remote Programmer (E59RP1)

After the Remote Programmer (E59RP1) is connected 

to your computer, affi x the circular end of the device 

onto the face of the sensor. Notice that it will adhere 

magnetically to the face of the sensor.

Observe the status indicators at the bottom of each 

programming screen. This will indicate when the link 

between the MyProx sensor and computer has been 

established. When the software has been launched, 

you will see these indicators at the bottom-right of the 

program window. 

Color Description

Dark green No data is being sent to the Remote 

Programmer (E59RP1) or Tray 

Programmer (E59TP1)

Light green Data is being sent from the computer 

to the Remote Programmer (E59RP1) or 

Tray Programmer (E59TP1)

Dark red No data is being received by the 

computer

Light red Data is being received by the computer

MyProx sensors also indicate a linked status when the 

output LED pulsates rapidly.

Customizing MyProx

The default settings within the MyProx software will be 

suffi cient to meet the needs of most users. However, 

you may want to further customize the settings to 

fi t your personal preferences. The Options window, 

accessible from the Tools > Options toolbar, allows you 

to do just that.

Startup Access Mode

For security and tracking functionality, the software 

includes two access modes. The fi rst, Supervisor 

Mode, is set by default and allows users to access 

all features of the program unrestricted. The second, 

Maintenance Mode, restricts the user to Cloning. Users 

with this restriction will not be able to program a 

sensor using the Confi gure method. 

Printer Settings

This is where printers are chosen for reports and 

labels.  
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Tray Clone Button Action

This option only applies to those who are using the 

Tray Programmer (E59TP1). The red button at the 

bottom-left of the E59TP1 can be programmed to 

fit your needs. By selecting Nothing, the button will 

remain inactive. By choosing Clone Station 1 to 2, the 

sensor in Station 1 (bottom-left) will be cloned to the 

sensor in Station 2 (bottom-right). By selecting Clone 

Station 1 to Other Stations, the sensor in Station 1 

will be cloned to all other stations. By choosing Clone 

Database to All Stations, the selected database entry 

will be cloned to all stations. This action will not work 

unless a database source has already been selected.

Verifications

Selected by default, Display Exit Verification will 

launch a confirmation window upon program exit. This 

prevents accidental shutdown of the application. The 

Enable Sounds option activated in-program sounds 

for actions like cloning success and failure. These 

sounds can be customized by going to the Sounds and 

Multimedia Control Panel. 

Database

As a tracking feature, cloned sensors are automatically 

saved to the database by default. To disable this 

feature, uncheck Automatically Save Cloned Sensors to 

Database. 

The Cross Reference Database, which holds all cross 

reference sensor configurations along with any user-

created configurations, is installed in the program 

directory. If the database file is moved elsewhere, the 

new location will need to be specified for database 

functionality to work. To specify the new location of 

the database, click the “...” button and select the new 

database location. With new versions of the software, 

we may expand the cross reference database to 

include new models. To simplify updating the software, 

it is recommended to keep the database in the 

program directory.

COM Port Scan

The software uses your computer’s COM ports to 

transfer data between the sensor and computer. 

The ports chosen to pass data depend on your 

computer configuration, but the port range is usually 

one through six. However, if you are experiencing 

problems communicating with the sensor, you can 

increase the range as needed. By increasing the range, 

the program may take longer to launch, as it must first 

scan all ports for programming devices. 

Custom Sensor List

The Custom Sensors List feature allows users to 

maintain their own list of favorite sensors, or custom-

configured sensors. These custom lists can be created 

by clicking on the Cross Reference Database entry 

under the Tools menu. You can select a custom list as a 

clone source by clicking the Cross Reference Database 

button on the Clone screen and picking your custom 

list entry at the bottom of the window. More detail on 

Custom Sensor Lists is available on Page 10.

This particular option specifies which custom list will 

be selected by default.  
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Chapter 3

Programming MyProx

There are essentially three different methods to 

programming your MyProx sensor: Confi gure, Clone 

and Teach. All three programming methods will be 

discussed in detail in this section. 

Using the Confi gure Screen

The Confi gure method can be used to program 

sensors one-at-a-time, and allows for the highest level 

of customization. Follow the below steps to program 

an MyProx sensor using the confi gure method.

Choosing the Sensor

Most of the controls on the Confi gure screen will be 

disabled until you have fi rst selected the sensor you 

wish to modify. First, pick the sensor from the drop-

down menu at the top-left of the screen. Once the 

sensor has been chosen, sensor confi guration controls 

will become enabled. If you do not see any sensors 

listed, you may want to refer to Chapter 2 and ensure 

your sensor is properly connected to your computer.

Changing Output Type

By default, DC versions of MyProx sensors come with 

Auto Confi guration enabled. This means the sensor 

will automatically detect on power-up whether to 

provide a Sinking Output (NPN) or Sourcing Output 

(PNP). Depending on your application, you may want 

to manually confi gure the Output Type. To change this 

setting, simply select the radio button that corresponds 

to your preference, or click the image to cycle through 

the selections. If you have a dual output MyProx 

Cloning sensor, you will be unable to choose Auto 

Confi guration as both outputs must be assigned to 

NPN or PNP. If you have an AC MyProx, you will not be 

able to manipulate output type.

Changing Output Mode

To change the condition of the sensor contact when the 

target is not sensed, choose either Normally Open or 

Normally Closed. To change this setting, simply select 

the radio button that corresponds to your preference, 

or click the image to cycle through the selections. 

Changing Sensing Range

A powerful feature of the MyProx is the ability to 

change Sensing Range, down to a tenth of a millimeter. 

To do this, simly enter a new number for Operate Point 

(the point at where a target is detected) and Release 

Point (the point at where the target is beyond the 

detected range). You can also manipulate the arrow 

controls to change the sensing range by a tenth of a 

millimeter in either direction. 
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Enabling Band Sensing

Band Sensing allows for the MyProx to detect an 

object within a specifi ed zone, or band. The MyProx 

will activate when the target passes through the zone 

axially. Should the object be outside of the band, or 

inside of the band, the sensor will remain in an inactive 

state. Band sensing can be enabled by checking the 

Enable Band Sensing checkbox in the Modify Sensing 

Range portion of the Confi gure screen. 

Change Response Time and Noise Immunity

Response Time is defi ned as the total time needed for 

a sensor to translate a change in operating condition 

into a corresponding change in output status. Noise 

Immunity is the ability of a sensor to ignore unwanted 

conducted or radiated electrical signals. Both are 

related—as response time is decreased, noise 

immunity increases. While the MyProx has inherently 

high noise immunity, there may be some applications 

where very high noise immunity is needed. To modify 

this setting, simply move the slider up or down. As you 

change settings, the new noise immunity and response 

time information is displayed.

If you have two MyProx sensors positioned in close 

proximity, the two sensors may interfere with one 

another. In the event this occurs, choose a setting 

where Side by Side is enabled. This will enhanced 

the sensor’s targeting algorithm and prevent signal 

collisions from neighboring MyProx sensors.

Response time also has an effect on speed detection, 

as explained in the Enabling Speed Detection section.

Enabling Output Delay

An advanced feature of the MyProx Cloning sensor 

is its ability to delay a change in output, known as 

Output Delay. There are two ways the sensor can delay 

its output change—when going from an inactive state 

to an active state (On Delay), and when going from 

an activated state to an inactive state (Off Delay). 

To enable delay, you must fi rst check the box that 

corresponds to the type of delay—on or off—you 

require. Once you have chosen the delay, the numeric 

fi eld to the right will become active and you can 

increase or decrease the setting as needed.

Enabling Speed Detection

Speed Detection, another advanced feature found only 

in the MyProx Cloning sensor, allows for the sensor 

to detect changes in time between targets. Enabling 

an Over Speed of 100 milliseconds, for example, will 

activate the sensor when the time between targets 

drops below 100 milliseconds (thus happening 

more frequently). Likewise, enabling Under Speed 

of 100 milliseconds will activate the sensor when 

the time between targets becomes greater than 100 

milliseconds (thus occurring less frequently). To enable 

speed detection, fi rst check the box that corresponds 

to the type of speed detection--over or under--you 

require. Once you have chosen the type of speed 

detection, the numeric fi eld to the right will become 

active. You can then increase or decrease the setting 

as needed. Consult Chapter 4, Troubleshooting, if you 

have problems enabling speed detection.

A minimum time will be loaded into the time selection 

window once speed detection has been enabled. This 

minimum time is based on the sensor’s maximum 

repetition rate. High noise immunity in conjunction 

with speed detection will greatly add to the minimum 

time allowed, and should only be used for very slow 

moving targets. 

Programming Your Changes

Once you have properly confi gured the sensor, you 

must click the Program button at the bottom of the 

screen to save your changes to the sensor. If you 

customize a sensor but would like to revert back to 

the sensor’s default out-of-box confi guration, click the 

Restore Defaults button located next to the Program 

button.
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Using the Clone Screen

The Clone programming method allows you to batch 

program up to four sensors at a time (when using the 

Tray Programmer) and program from database entries 

or sensor fi les. To perform a clone operation, you must 

fi rst select both a source and a destination.

The fi rst step in the cloning process is selecting the 

sensor data source. You can select from three different 

clone data sources, listed and explained below

Selecting Sensor as Clone Source

If you have an MyProx sensor connected to your 

computer through a Remote Programmer (E59RP1) or 

Tray Programmer (E59TP1), you can use this sensor 

as a data source. When selected as the source, the 

confi guration will be read from the sensor and applied 

to the destination upon programming. To select the 

sensor as the clone source, pick it from the list of 

available sources in the left-hand column. 

Selecting Sensor File as Clone Source

A sensor fi le (also known as an ipx2 fi le) can also be 

used as a clone data source. Simply select Sensor 

File as the clone source. A new window will appear. 

Specify the location of the existing sensor fi le on your 

computer, and click the Open button. If you do not 

have a sensor fi le, see the next section for creating 

one.

Selecting Database Entry as Clone Source

A Cross Reference Database entry can be used as 

a clone source. This database holds about 5,000 

competitive model confi gurations. Upon selecting 

Cross Reference Database as the source, a new 

database window will appear. Here, you can browse 

among competitive sensors and quickly identify a 

particular sensor confi guration using the Advanced 

Filters. To fi lter, simply choose which fi eld you would 

like to search and then enter the search criteria in the 

corresponding fi eld below. The results will be fi ltered in 

real-time. Once you have found the appropriate sensor 

listing, select it by clicking on the listing itself and click 

the OK button. Your confi guration will then be loaded 

as clone source.
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To speed up the process of selecting a sensor for 

cloning, you may fi nd it convenient to create a Custom 

Sensors List. To create a custom list, select Custom 

Sensors Lists from the Tools drop-down menu. Click 

the Create New List button, enter a unique list title, 

and click OK. Your new list will now become visible 

to the right of the screen. To add a sensor to this 

newly created list, simply move or copy a sensor 

confi guration from another list by using the arrow 

buttons. Remove all sensor confi gurations within a 

custom list to permanently delete it.

The second step in the cloning process is specifying 

a clone destination. The three clone destinations are 

listed and explained below.

Selecting Sensor as Clone Destination

If you have an MyProx sensor connected to your 

computer through a Remote Programmer (E59RP1) or 

Tray Programmer (E59TP1), you can use this sensor as 

a clone destination. When selected as the destination, 

the source confi guration will be written to the sensor 

upon programming. To select a sensor as a destination, 

simply click on the sensor entry in the right-hand 

column. If you are using a Tray Programmer, you can 

select up to four sensors as a destination.

Selecting Sensor File as Clone Destination

A sensor fi le (also known as an ipx2 fi le) can be used 

as a clone destination. Simply select Sensor File as 

the clone destination. A new window will appear. 

Specify where you would prefer to place the fi le 

on your computer, and click the Save button. Upon 

programming, the source data will be written to the 

sensor fi le at the location specifi ed. Once a sensor fi le 

has been created, it can be used as any other fi le. You 

can archive it on your computer, send it to a coworker 

as an email attachment, and so on.

Selecting Database Entry as Clone Destination

By default, all cloning operations are saved as an 

entry into the Cross Reference Database. To change 

this option, see Customizing MyProx in Chapter 2. 

When you perform a cloning operation, the database 

entry window will appear. Here, you enter information 

for your custom sensor confi guration. To save the 

confi guration to the database, you must specify a 

unique Catalog Number.
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Using the Teach Screen

The Teach method of programming can only be used 

with the Remote Programmer (E59RP1), and allows 

you to customize sensing range, background metal 

rejection and more while the sensor is in its fi nal 

application. The Tray Programmer (E59TP1) does not 

have this functionality. However, you can teach a 

sensor while in its application environment and then 

clone it to the database or other MyProx sensors using 

the Tray Programmer. 

Follow the below steps to perform a teach operation.

1. Place the MyProx sensor in its fi nal operating 

environment.

2. Connect an MyProx sensor to your computer 

using a Remote Programmer (E59RP1).

3. Open MyProx and click on the Teach tab.

4. Select the MyProx sensor you wish to teach 

from the drop-down menu. Once the sensor 

confi guration has been loaded, the teach 

buttons will become enabled.

5. Click on the Teach Mode button that 

corresponds to the programming action your 

require. To program sensing range based on 

target location relative to the sensor, click 

Teach Sensing Range and Hysteresis. To teach 

the sensor to ignore peripheral metal objects, 

click Teach Background Rejection. To reset 

the maximum range of the sensor if it has 

been previously modifi ed, click Recalibrate 

Maximum Range.

6. Follow the step-by-step process to fi nalize each 

teach operation.
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Chapter 4

Troubleshooting

This chapter contains a comprehensive list of 

frequently asked questions, as well as contact 

information to request technical support if needed.

Frequently Asked Questions

Below is a listing of frequently asked questions, 

organized by category.

Installation Related

What should I do if an error message appears during 

installation, indicating the drive is write protected or I 

do not have permission to install the software?

How do I uninstall MyProx?

Where is the location of driver fi les needed for 

installation on my Windows NT4 machine?

What shall I do if I receive a Windows Logo 

Certifi cation warning during installation?

Remote Programmer (E59RP1) Related

When using the Remote Programmer (E59RP1), does 

it matter which side of the device I place on the face of 

the sensor?

What if I do not have a serial port on my computer to 

plug in the Remote Programmer (E59RP1)?

Tray Programmer (E59TP1) Related

How do I power the Tray Programmer (E59TP1)?

What do the blinking LEDs mean on the Tray 

Programmer (E59TP1)?

What is the red square button in the lower left-hand 

side of the Tray Programmer (E59TP1)?

How do I obtain more connector power cables for the 

Tray Programmer (E59TP1)?

Why can’t I program any teach functions using the Tray 

Programmer (E59TP1)?

What if I need a replacement power transformer for the 

Tray Programmer (E59TP1)?

Sensor Related

Why is the output type incorrect when I programmed it 

for Auto Confi guration?

I used the teach mode to program a new sensing 

range, but it appears the sensor is operating in band 

sensing mode.

I used the teach mode to program band sensing, but it 

does not appear to work.

What does the blinking LED mean on the sensor?

I recalibrated the maximum sensing range on my 

sensor, but the range is nowhere near the rated 

maximum.

Software Related

Why do I receive a COM port error when attempting 

establish connection with the sensor?

Why can’t I click on the Confi gure tab? It appears to be 

disabled.

Why are certain confi guration options not selectable 

within the confi gure screen?

Why can’t I clone my MyProx sensor?

How do I clone from a competitive sensor?

What is a Custom Sensor List?

How do I remove a Custom Sensor List?

What is an IPX or IPX2 fi le?
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What should I do if an error message appears during 

installation, indicating the drive is write protected or I 

do not have permission to install the software?

Offi ce computers often require administrative 

privileges to install new software. Consult your 

network administrator or IT Manager to install MyProx.

How do I uninstall MyProx?

Go to the Start Menu, locate the Meyle folder and click 

Uninstall MyProx. Follow the instructions that appear 

on-screen. The uninstaller will remove the program 

fi les, but your sensor database will remain.

Where is the location of driver fi les needed for 

installation on my Windows NT4 machine?

If you computer is running Windows NT4, installation 

will prompt you for the location of specifi c driver fi les 

needed for USB connectivity. The requested driver 

fi les can be found on the MyProx compact disc. At the 

prompt, choose the drive letter that corresponds to 

your computer disc drive and click OK. 

What shall I do if I receive a Windows Logo 

Certifi cation warning during installation?

During installation, you may receive a Windows Logo 

Certifi cation Warning. Disregard this message and click 

Continue Anyway. This program has been developed 

for Windows 98/2000/XP and has undergone rigorous 

testing to ensure a quality product.

When using the Remote Programmer (E59RP1), does 

it matter which side of the device I place on the face of 

the sensor?

Both sides of the Remote Programmer (E59RP1) 

provide equal signal strength. However, the machined 

side is physically designed to closely fi t the MyProx 

face cap.

What if I do not have a serial port on my computer to 

plug in the Remote Programmer (E59RP1)?

Some computers are designed without a serial 

port. However, these computers will usually have at 

least one USB port. In this case, Serial (DB9) to USB 

adapters are available at computer retail outlets.

How do I power the Tray Programmer (E59TP1)?

The Tray Programmer is powered by an included 

AC Adapter. You can confi rm the unit is powered by 

verifying an active LED on the back panel. If the unit 

is powered but not establishing a connection with the 

computer, verify your USB cable is securely plugged 

into both ends. Once the device has been connected, 

launch MyProx and the device should be detected by 

the software. Detection will occur when the four LED 

indicators on the Tray Programmer face power green.

What do the blinking LEDs mean on the Tray 

Programmer (E59TP1)?

A solid green LED indicates the sensor is ready for 

programming. A blinking green LED indicates the 

sensor has fi nished programming. A blinking red LED 

indicates the sensor is being programmed.

What is the red square button in the lower left-hand 

side of the Tray Programmer (E59TP1)?

By default, this button will do nothing. However, within 

the software you can specify a new default action by 

going into the Tools > Options menu. See Chapter 2 for 

more details on customizing your software.

How do I obtain more connector power cables for the 

Tray Programmer (E59TP1)?

Contact Meyle to order additional Micro AC or DC 

Connector Cables. Catalog numbers are E59DCMICRO, 

E59ACMICRO, E59ACMINI and E59CBL. Two 

replacement pieces are included per package.
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Why can’t I program any teach functions using the Tray 

Programmer (E59TP1)?

The teach function requires that the MyProx sensor 

be installed in its fi nal operating environment for 

programming to be successful. However, a sensor can 

be programmed in the application and then saved to 

the Cross Reference Database or a Sensor File. From 

there, it can be used as a clone source.

What if I need a replacement power transformer for 

the Tray Programmer (E59TP1)?

Meyle does not provide replacement power 

transformers at this time. Please consult your local 

electronics retailer for replacement.

Why is the output type incorrect when I programmed 

it for Auto Confi guration?

When output type is programmed as Auto 

Confi guration, the sensor will automatically confi gure 

its output at startup based on the polarity of the 

load. Power has to be cycled to the sensor after 

programming for Auto Confi guration to take effect. 

If the sensor’s output is wired in series with another 

switching device, Auto Confi guration may fail because 

the sensor will not be able to sense load polarity when 

other devices are open. In this case, manual output 

selection is recommended.

I used the teach mode to program a new sensing 

range, but it appears the sensor is operating in band 

sensing mode.

The Operate Point was set further than the release 

point. To solve this problem, reprogram your Operate 

Point and Release Point so that the Operate Point is the 

closest point to the sensor face.

I used the teach mode to program band sensing, but it 

does not appear to work.

The Near Operate Point was set further from the 

sensor face than the Far Operate Point. To solve this 

problem, reprogram your MyProx sensor with the Near 

Operate Point closer than the Far Operate Point.

What does the blinking LED mean on the sensor?

When the LED blinks consistently on the tail piece of 

the sensor, it is currently in linked mode. When it blinks 

twice, the sensor has been successfully programmed. 

When it blinks four times, no target was acquired 

during the teach operation. 

I recalibrated the maximum sensing range on my 

sensor, but the range is nowhere near the rated 

maximum.

The Recalibrate Maximum Range Teach command 

instructs the sensor to re-learn its target-free magnetic 

fi eld. If any metal, or even the Remote Programmer 

(E59RP1) face interfered with this measurement during 

the recalibration process, the sensor would not have 

been taught the true target-free fi eld. To correct this, 

simply redo Recalibrate Maximum Range making sure 

to remove all metallic objects that could be within 

range (up to three times the rated sensing range).

Why do I receive a COM port error when attempting 

establish connection with the sensor?

This error could indicate one of three problems. First, a 

confl icting application may already be using the COM 

port. Some examples are PDAs and other devices. 

Close all confl icting applications, such as HotSync 

for PDAs, and restart MyProx. Second, all available 

COM ports may have been previously disabled in the 

Windows Device Manager. To correct this problem, 

open the Windows Device Manager and select Ports 

from the list of devices. Select one of the COM ports 

shown and enable it. Lastly, if your laptop includes 

an IRDA port, it may prevent use of the serial port. 

To correct this problem, go to the Windows Device 

Manager and disable the IRDA Port located under the 

Infrared Devices category. Then, enable the COM ports 

under the Ports category. It may be necessary to restart 

the computer for these changes to take effect. 
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When I click the Confi gure tab, I cannot modify the 

sensor even though it is properly connected. Why do 

all the controls appear to be disabled?

You may be in Maintenance Mode, which restricts use 

of the Confi gure screen. From the toolbar, select 

View > Mode > Supervisor to gain full access to 

software features.

Why are certain confi guration options not selectable 

within the confi gure screen?

The standard MyProx lacks advanced programming 

features such as Output Delay and Speed Detection. 

Certain version of MyProx, such as AC sensors, are not 

capable of Auto Confi guration outputs. 

Why can’t I clone my MyProx sensor?

Only the MyProx Cloning Sensor may be programmed 

from the Clone screen. To verify your MyProx Cloning 

sensor, look for a part number starting with E59-M. If 

you sensor’s part number starts with E59-F, this is a 

standard MyProx without the cloning functionality.

How do I clone from a competitive sensor?

You cannot use the programming station to pull 

characteristics from a non-MyProx sensor. However, 

you can select competitive catalog numbers from the 

Cross Reference Database. Furthermore, you can use 

the Confi gure screen to customize an MyProx sensor 

to closely match a competitive model.

What is a Custom Sensor List?

A Custom Sensor List is a category grouping within 

the database. By default, the only Custom Sensor Lists 

are competitive brands. But you can easily add and 

manage new custom lists by going to the toolbar and 

selecting Tools > Custom Sensor Lists.

How do I remove a Custom Sensor List?

Remove all confi gurations from the list and it will be 

removed automatically.

What is an IPX or IPX2 fi le?

These fi les contain sensor confi gurations that have 

been exported from MyProx or previous versions. 
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Chapter 5

Glossary

Auto Confi guration A setting where the sensor detects upon power-up whether to provide a Sinking (NPN) or

 Sourcing (PNP) output.

Band Sensing The ability of a sensor to laterally sensing in a band, or zone.

Confi gure A one-at-a-time programming method which allows for the highest level of customization.

Clone The ability of a sensor to read another sensor’s confi guration and change its operation   

 accordingly.

Cross Reference  A built-in feature of the MyProx which allows cloning sensor

Database confi gurations to and from the database.

Custom Sensor  A user made list created to store favorite sensor confi gurations.

Lists

Far Operate Point In band sensing mode, the maximum distance at which the sensor changes state.

Ferrous Material composed of iron, or which contains iron.

Hysteresis The difference between operate point (where target is detected) and release point (where

 target is no longer detected).

Maintenance Mode A restricted software profi le where the Confi gure programming method is disabled.

Noise Immunity The ability of a sensor to ignore unwanted conducted or radiated electrical signals. The

 magnitude of this noise signal is measured in terms of volts per meter (V/m) over a wide

 range of frequencies likely to be encountered by the device under use.

Normally Closed The closed condition of the sensor contact when the target is not sensed. 

Normally Open The open condition of the sensor contact when the target is not sensed.

Off Delay A time delay, usually measured in milliseconds, when going from an active state to an   

 inactive state.

Operate Point The distance from the sensor face at which the target is detected.

On Delay A time delay, usually measured in milliseconds, when going from an inactive state to an

 active state.

Output Delay A delay, usually measured in milliseconds, between a change in the sensor’s output.

Release Point The point at which the target is beyond the detection range of the sensor, or the point at

 which the sensor was programmed to return to an inactive state.
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Remote Programmer An MyProx accessory which connects an MyProx sensor to a computer or laptop.

Response Time The total time needed for a sensor to translate a change in operating condition in to a

 corresponding change in output status.

Sensing Range The distance from a sensor to the target, or a programmed point at which the sensor will

 activate.

Shielded A sensor which is fully embeddable.

Side by Side A special Response Time and Noise Immunity mode that activates 

Speed Detection An advanced feature of the MyProx Cloning Sensor which allows it to detect changes in the

 time between targets. 

Supervisor Mode An unrestricted profi le within the software that allows for full programming functionality.

Teach A programming mode whereby a sensor is programmed while in its fi nal application

 environment, thus requiring use of a Remote Programmer.

Tray Programmer An MyProx accessory that allows for up to four MyProx sensors to be programmed at 

once,

 when used in conjunction with the MyProx.

Unshielded A sensor typically not embeddable unless a clearance area is provided or the sensor is

 programmed to ignore side metal.


